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CHAPTER 1:  SYSTEM BASICS 
 
A. Overview  

1. When should I read this 
chapter? 

Read this chapter after you’ve read the Introduction, and after you’ve installed the 

software (see the on-disc instructions or Appendix B: Installation and Setup to 

install the software).  You will learn more from this chapter if you can follow 

along on your computer. 

2. What is the purpose of this 
chapter? 

Use this chapter to familiarize yourself with the system basics of ICMS.  The 

information presented here will help you learn to navigate through ICMS.  

After you start working in the program, use this chapter as a quick reference 

on system basics. 

B. Getting Started  

1. How do I start the program? From your Windows desktop: 

 

• Double-click the Re:discovery icon   

 

Or follow these steps: 

 

• Single-click on the Start button in the bottom left corner of the screen to 

bring up the start menu. 

 

• Point to All Programs on the Start menu.  When you highlight All 

Programs, the Programs menu opens. 

 

• Highlight the Re:discovery ICMS folder on the Programs menu. 

 

• Single-click on the Re:discovery ICMS icon. 

 

The Login window opens.  Enter your User ID.  Press Tab to move to the 

Password field and enter your password.  Press Enter or click on the Login 

button to start the program. 
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2. What if I don’t have a User 
ID and password? 

If you don't have a user ID and password, stop and return to: 

 

• Appendix B:  Installation and Setup, or  

 

• Chapter 9, Section VI, User Security, to set up a user ID, or 

 

• your system administrator who will assign you a user ID and password 

 

If you have forgotten your password, see your ICMS system administrator.  If 

you need further help, call for support.  See Appendix K: Support. 

3. What is the Home Page? 
 

The Home Page opens the first time you log in to ICMS.  It shows the 

program’s modules and directories in a “tree”.  Use the arrow keys and the 

Enter key, or double-click the mouse in the Home Page, to select the option 

you want to use.  Click the blue + buttons to expand an option and view sub-

options within it. 

 

 
 

All units have the: 

 

• Collections Module (This contains your cultural resources and natural 

history catalog records.  It also contains associated modules that assist you 

with collections management functions.)   

 

• Archives Module (This contains screens for describing archival 

collections.) 

 

• Management Reports Module (This contains the Automated Checklist and 

Collections Management Report modules.) 

4. What if I don’t have any 
Collection or Archive 
directories in ICMS? 

If you have just installed ICMS for the first time, you must create one or more 

directories so you can enter your catalog data. 

 

Note: You must have Administrator rights to create directories.  If you do not 

have sufficient rights to create directories, contact your ICMS system 

administrator. 
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To create a directory: 

 

• from the Tools menu, choose Create New Directory.  The Create New 

Directory window opens. 

• Enter a 3-5 character directory name, usually your unit acronym. 

• Select a Directory Type.  Check the box for “Use DOI or NPS Center 

Model Directory” to create a standard DOI directory.  If you do not 

use a DOI or NPS Center model directory, a standard NPS directory 

will be created. 

 

 
 

DOI directories use an unformatted catalog and accession number, which 

allows any numbering format for all bureaus.  NPS directories use the standard 

NPS 3-part catalog and accession number format.  Only NPS Centers will use 

the NPS Center model directories. 

 

Most units will create at least a Cultural Resources directory.  Many units will 

also create a Natural History directory. 

 

Click the Create Directory link to create the directory.  Your new directory 

will appear under Collections or Archives in the Navigator. 

5. How do I get to the 
Collections Module? 

To get to the collections module: 

 

• from the Home Page, double-click on the icon for a Collections directory, 

such as Cultural Resources or Natural History, or 

• use your arrow keys to cursor to a Collections directory, such as Cultural 

Resources or Natural History, and press the Enter key 

 

Note:  If you are using the Navigation Pane, you only need to single-click a 

selection to open it. 

 

The Directory Page opens. 

 

Collections Directory Page 
The Directory Page includes the collections records, utilities, and associated 

modules for the directory you chose.  
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 The Collections directory page will look something like this: 

 

 
 

Note:  In this manual, the acronym “PARK” is used to indicate any unit.  

When you use ICMS, your unit acronym will appear in place of “PARK”. 

 

From the Directory Page double-click “Catalog Records”, or use the arrow 

keys to select “Catalog Records” and press the Enter key. 

 

The Catalog Record page opens.  You will see the first screen of data for your 

first catalog record.  The default sort order is by catalog number, so you will 

see the record with the lowest catalog number in the directory.  A cultural 

resources directory contains history, archeology, ethnology and archival 

records.  A natural history directory contains biology, geology and 

paleontology records. 

 Some of the options in ICMS are security protected.  To access these options, 

you must have the correct security rights assigned to your User ID.  If you 

do not have the correct security rights, the option will be unavailable.  For 

more information on security rights, see Chapter 9, Section VI, User 

Security. 

 
6. How do I move through the 

database and look at the 
other records? 

There are many options and functions available to move through the program.  

You need to find the ways that work best for you.  Start by looking at the 

different parts of the screen that are described in the following sections. 

 

Go to question B.9 to begin learning how to navigate and use ICMS. 

7. How do I get to the Archives 
Module? 

To get to the archives module: 

 

• single-click on the icon for an Archives directory, such as Archives or 

Item Level Archives, or 

 

• use your arrow keys to cursor to an Archives directory, such as Archives 

or Item Level Archives, and press the Enter key 

 

The Directory Page opens. 
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Archives Directory Page 
The Directory Page includes the collections records, utilities, and associated 

modules for the directory you chose.  An archives directory contains 

hierarchically organized records.  An item level archives directory contains 

records for archival items cataloged only at the item level. 

 

The Archives directory page will look something like this: 

 

 
 

From the Directory Page double-click “Collection”, or use the arrow keys to 

select “Collection” and press the Enter key. 

 

The Collection page opens.  You will see the first screen of data for your first 

archival collection record. 

8. Can I use the Archives 
Module if I don’t have 
archival expertise? 

Yes.  However, the module is intended for use by DOI or contract staff with 

experience in describing archival collections.  You must fully catalog an 

archival collection in the Collections Module.  Once you have a catalog record 

for the collection, you can choose at any time to transfer the data to the 

Archives Module. 

9. How do I exit the program? To exit the program: 

 

• single-click on the Exit icon  or 

 

• press Alt-F to open the File menu, then use your arrow keys to cursor 

down to Exit and press the Enter key 

10. What are the main parts of 
the ICMS window? 

The ICMS window has the following main parts: 

Menu Bar The menu bar is at the top of the window.  It includes all the commands and 

functions for working with ICMS.  For more information on the menu bar, see 

Section C. Menu Bar. 

 



System Basics 1:6 ICMS User Manual (2015) 

 

Button Bar The button bar is below the menu bar.  It includes the most frequently used 

commands and functions.  For more information on the button bar, see Section 

D. Button Bar. 
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Navigation Pane The navigation pane is on the left side of the window.  It includes the 

Navigator, Field Help, and Quick Actions.  You can hide any of these options 

by using View, Navigation Pane Options.  You can hide the entire navigation 

pane by clicking the  icon in the button bar, or by choosing View, 

Navigation Pane, from the menu bar. 

 

 

List Pane The list pane is below the button bar.  It shows the list of visible records.  You 

can sort (i.e. organize) the records in the list by using the Sort option, or by 

clicking the column headers (“quick sort”) in the list pane.  You can hide the 

entire list pane by clicking the  icon on the button bar, or by choosing 

View, List Pane, from the menu bar. 

 

 

Record Pane The record pane shows the record you are currently working with.  It will have 

different fields and different layout, depending on which module or associated 

module you are using. 
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Status Bar The status bar is at the bottom of the window.  It shows the number of records 

in your visible data, the current mode of operation, and whether you are using 

an active tag or filter.  It also includes a progress meter, to indicate when the 

system is working on a task. 

 

 

C. Menu Bar  

1. What is the purpose of the 
menu bar across the top of 
the screen? 

The menu bar is one way for you to access the many functions of ICMS. 

2. How do I access the 
functions on the menu bar? 

Press Alt and the first letter of the word on the menu bar to see a pull-down 

menu of choices for that selection.  If you continue to hold the Alt key after 

pressing the menu letter, you can then press the underlined letter of the 

function you want to choose on that menu. Or single-click on the function you 

want, or use your arrow keys to highlight a choice and press the Enter key.  
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 To go to another menu, release the Alt key and then press Alt and the first 

letter of the next menu you want to view.  With a menu expanded, you can 

also press the right or left arrow key to open another menu. 

 

Note:  You must be in the View Mode to access some of the functions on the 

menu bar.  The current mode is shown on the status bar in the bottom right 

corner of the screen.  Refer to Section F of this chapter for additional 

information about modes. 

 

Following is a list of the menu bar commands and a brief explanation of them.  

Many of these commands are described in greater detail in other parts of this 

manual. 

 Some of the options in ICMS are security protected.  To access these options, 

you must have the correct security rights assigned to your User ID.  If you do 

not have the correct security rights, the option will be inactive.  For more 

information on security rights, read Chapter 9, Section VI, User Security. 

 
3. What options appear under 

File on the menu bar? 
The File menu includes functions for using or creating computer files with 

ICMS. 

Import/Export 
 

Use this option to import data into the program, or export data from the 

program.  You can import or export selected data fields, using an ASCII 

delimited file format.  You can also export data directly to files in these 

formats: Excel, HTML, PDF, text, or XML.  See Chapter 8, Sections III and 

IV, for more information on import/export. 

Print Preview Use this option to preview what will print with the Print List option. 

Print List Use this option to print the list of visible data.  The fields and records included 

in the printout will match those in the List Pane. 

Launch E-mail Use this option to start your computer’s e-mail program. 

Backup Data Use this option to backup your data files, including backups for your annual 

National Catalog submission.  See Chapter 9, Section II for more information 

on backup. 

Restore Full System Backup Use this option to restore a complete system backup zip file.  This option is 

used for restoring a system after a computer crash or to move the data to a new 

computer.  See Chapter 9, Section III, for more information on restoring a full 

system backup. 

Data Updates (formerly laptop 
copy) 

Use this option to copy records to or from a laptop computer.  See Chapter 8, 

Section V, for more information on laptop copy. 

Load to Empty Directory Use this option to load data you receive from another ICMS user, such as a 

contract cataloger, cooperator, or a Center.  You must create a new empty 

directory to use this option.  See Chapter 8, Section VI, for more information 

on loading data. 

Transfer Use this option to transfer (copy) records from one directory to another, or to 

copy records to a file.  See Chapter 8, Sections I and II, for more information 

on transfer. 
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Log on as different user Use this option to log into ICMS with a different User ID. 

Exit Use this option to exit the program. 

4. What options appear under 
Edit on the menu bar? 

The Edit menu includes options for adding or changing data. 

Undo Use this option to undo the most recent typing or deleting that you just did 

while adding, modifying or copying a record. 

 

Note:  This is only available during the same add, modify or copy session.  

Once the record is saved, the Undo will no longer reverse the typing. 

Cut Use this option to cut the selected text from a record. 

 

Note: You must be in Add, Modify, or Copy mode to remove text from a 

record.  The current mode is shown on the status bar in the bottom right corner 

of the screen.  Refer to Section F of this chapter for additional information 

about modes. 

Copy Use this option to copy the selected text, so you can paste it in another 

location.  Copied text is held in the Windows “clipboard”.  You can paste the 

text into a Word document, e-mail, etc. 

Copy/Append Use this option to copy selected text from more than one ICMS field.  After 

selecting and copying one piece of text, select another piece of text and use 

Copy/Append.  Both pieces of text are held in the Windows clipboard, waiting 

for you to paste them. 

Paste Use this option to Paste the text you’ve copied to the Windows clipboard. 

Select All Use this option to quickly highlight all the text in a single field. 

Add New Record 
 

Use this option to create a new record.  Add creates a new blank record and 

places you in Add Mode.  In the Collections module, the last acronym that was 

used for the catalog and accession number will appear on the record.  After 

you save the new record, the program returns to Menu Mode.  For more 

information on adding or modifying catalog records, see Chapter 2, 

Cataloging. 

Copy This Record 
 

This option allows you to make an exact copy of the record currently displayed 

on the screen and then to edit the new record.  You cannot save the copy 

unless you change the catalog number.  This option places you in Copy Mode, 

so that you can modify the catalog number and any other fields. 

Modify This Record 
 

Use this option to modify the contents of the record currently on the screen.  

You may change previously entered data or enter new information.  This 

option places you in Modify Mode. 

Delete Record(s) Use this option to delete one or more selected records from the database.  You 

can delete the record that is currently on the screen by choosing "Delete This 

Record."  You can delete a group of records by choosing "Delete Multiple 

Records."  Use caution when using this option. 
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 Note:  Delete permanently removes the record from the database without 

any recovery options.  Make sure you have reliable backups of your data 

before deleting records. 

 
Refresh 

 

Use this option to refresh the screen if other users have modified the record 

since you began to view it. 

Defaults & Carry Over Fields Use this option to set default values and carry over values to help you quickly 

add new records that are similar.  Using defaults can eliminate repetitive data 

entry.  You can set defaults for the entire system and set unique defaults for 

every person who enters data.  For example, a cataloger entering data on 

magazines and a cataloger entering data on silverware can set unique defaults.  

See Chapter 6, Section VII, for more information on Defaults. 

Macros Use this option to assign a keystroke or double-key combination to a series of 

actions that you perform frequently.  When you type the assigned keystroke, 

the program performs the action.  You can keep macros for one data-entry 

session or save them for repeated use.  See Chapter 6, Section VIII, for more 

information on Macros. 

Mass Supplemental Update Use this option to mass-update the supplemental data for a group of records.  

You can attach a group of catalog records to an Exhibit record, or a Loan Out 

record.  You can update or add appraisal information for many records at the 

same time.  See Chapter 3, Section I.E., for more information. 

Modify All Records 
 

Use this option to modify multiple records.  You can update the contents of 

one, or many fields, in a group of records.  Modify All will replace the current 

data in the field with the new data you specify.  You can also append data to 

the end of the existing data in a field.  See Chapter 6, Section III, for more 

information on Modify All Records. 

Mass Association Records 
Update 

Use this option to attach multiple catalog records from one directory to an 

association (grouping) of similar catalog records including those in different 

directories and modules.  You can associate items of similar subject matter, 

similar origin or other commonality.  For example, if you have catalog records 

in a Cultural Resources directory and a Natural History directory that were 

collected by the same individual, you can create an association between them.  

See Chapter 6, Section IX, for more information on Associate Records. 

Global Search and Replace Use this option to seek and correct specific data, such as a string of characters 

or a frequently misspelled word.  You can search all fields, or a specific field.  

You can replace all instances at once, or view and replace each instance one at 

a time.  See Chapter 6, Section IV, for more information. 

Quick Entry 
 

Use this option to edit or add information to a group of selected records in a 

columnar format, instead of using the data entry screens.  This format allows 

you to choose the fields you wish to edit and move through the fields quickly.  

See Chapter 6, Section V, for more information on Quick Entry. 

Build Exhibit Label Use this option to build a formula (template) of fields to display in the Exhibit 

Label field on the Unit tab of selected catalog records.  See the Field-by-Field 

instructions in Chapter 2 for each discipline.  You can then use Modify All 

Records and enter {exhibit label} in the Exhibit Label field to update records 
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with this label formula.  See Chapter 6, Section III, for more information on 

Modify All Records. 

Pre-allocate Records Use this option to pre-assign catalog numbers to a defined set of empty catalog 

records.  Sites that do a great deal of cataloging, or that use contract catalogers, 

may use this function.  Pre-allocated records will be DRAFT status, and will 

have the Class 1 discipline that you choose.  See Chapter 6, Section VI, for 

more information on Pre-allocate Records. 

 

Note: Pre-allocate records is a security-protected function.  You must have 

System Administrator security to use this function.  It is only available in the 

NPS-style CR & NH Catalog Records. 

Mass Taxonomy Update Available only in Natural History.  Use this function to mass update the 

Kingdom, Phylum, Class, Order, Family and Sci. Name fields on groups of 

Biology or Paleontology records from the ITIS database.  See Chapter 2, 

Cataloging (Natural History and Paleontology sections), for more information 

on Mass Taxonomy Update 

MARC Archives module only.  Use this function to create or export MARC records 

at the Collection level of a 4-level archives directory.  See Appendix F, 

Section M for more information on MARC records. 

5. What options appear under 
View on the menu bar? 

The View menu includes options for organizing the ICMS screens, using 

images, and navigating the screens and modules. 

Navigation Pane Use this option to close or open the ICMS Navigation Pane.  The navigation 

pane is on the left side of the screen.  It includes the Navigator “tree”, Field 

Help, and Quick Actions.  You can use the navigator to go to associated 

modules such as Accessions, Exhibits, and Loans. 

List Pane Use this option to close or open the List Pane.  The list pane is above the 

record pane.  It shows the list of visible records in the current module. 

Record Pane Use this option to close or open the Record Pane.  The record pane shows the 

data you are currently working with. 

Navigation Pane Options Use this option to activate or deactivate the elements within the navigation 

pane.  You can activate or deactivate the Navigator, Field Help, and Quick 

Actions elements.  

Navigation Pane Style Use this option to change the style of the navigation pane to suit your 

preference.  You can set the style to match the default style of other Windows 

applications, such as Outlook 2003, Outlook XP, and Windows Explorer XP. 

Toolbars Use this option to activate specialized toolbars.  When you activate a toolbar, 

frequently used functions such as Tag Set Management are available on-

screen.  You won’t have to search the menus to find these functions, because 

they’ll be on the screen as part of the button bar. 

Screen Options Use this option to change the overall style of the ICMS window to suit your 

preference.  There are several styles to choose from.  See Section L.7 of this 

chapter, for more information on Screen Options. 
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Imaging Use this option to import digital images to your catalog records, and manage 

those images.  You can attach one or more images to each catalog record. For 

more information on images, read Appendix G, Imaging and Multimedia. 

Image(s) View Use this option to select the image view that suits your preference.  You can 

choose to view images as a Film Strip, Thumbnails, or Slide Show.  You can 

also “dock” the images tab, so that it is always next to your catalog record. 

Multimedia Use this option to activate multimedia clips that are associated with a catalog 

record.  See Appendix G, Imaging and Multimedia, for more information on 

Multimedia. 

Show Images in List Pane Use this option to include thumbnail images in the List Pane.  Any record that has 

an image attached to it will show that image in the list. 

Show Only Records With 
Images 

Use this option to limit the visible data to only those records that have images 

attached to them. 

Update My List View Use this option to select the fields you want to appear in the List Pane.  These 

fields will appear in the list pane when you choose My List View from the Sort 

pull-down menu on the button bar or the Record menu. 

Use Large Data Navigator Some units have very large collections and as a result a single table in a 

directory may contain a large number of records.  Use this option to interact 

with Large Data Sets, so the system only has to load a certain number of 

records at a time and can work more efficiently.  Your visible data is still all 

records in the system, Tag Set, or filter, but the records are divided into pages 

and only one page of records is downloaded to the workstation at a time. 

Back Use this option to go back to a screen you viewed previously, such as another 

module, directory, or associated module. 

Forward Use this option to go forward to a screen you viewed previously, such as another 

module, directory, or associated module.  This option is only active after you have 

used the Back option. 

Next Page Use this option to view the next page (screen) of data in multi-screen modules. 

Previous Page Use this option to view the previous page (screen) of data in multi-screen 

modules. 

Go To Use this option to go to any of the associated modules or utilities within the 

current directory. 

6. What options appear under 
Record on the menu bar? 

The Record menu includes options for working with your records.  Use these 

options to find records, move among the records, and print records. 

Use Hierarchical Ranges Archives module only.  Use this option to activate/deactivate the use of 

hierarchical ranges.  When active, this option limits the visible data to the 

records within the same range as the current Collection, Series, or File Unit.  

When inactive, all records are visible. 
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View Hierarchical Browse Archives module only.  Use this option to open the Hierarchical Browse 

window.  The window displays Collection, Series, File Unit, and Item level 

records in a color-coded hierarchy.  The window can remain open while you 

work with records. 

Sort Use this option to organize your records.  You can put your records in order by 

Catalog Number, Location, Object Name, etc.  The default sort is by catalog 

number. 

 

The list of available sort orders changes in the different modules and 

associated modules.  For more information and a complete list of available sort 

orders, by module, see Chapter 7, Section V. 

First Record 
 

Use this option to go to the first record in the visible data, in order by the 

current Sort.  If a filter or tag is active, this option will move to the first record 

in the filter or tag.  This option is inactive if you are on the first record. 

Previous Record 
 

Use this option to go to the previous record in your visible data, in order by the 

current Sort.  The previous record is the record directly before the one 

currently on the screen.  If a filter or tag is active, Previous Record will move 

to the previous record in that filter or tag.  This option is inactive if you are on 

the first record. 

Next Record 
 

Use this option to go to the next record in your visible data, in order by the 

current Sort.  The next record is the record directly after the one currently on 

the screen.  If a filter or tag is active, Next Record will move to the next record 

in the filter or tag.  This option is inactive if you are on the last record. 

Last Record 
 

Use this option to go to the last record in the visible data, in order by the 

current Sort.  If a filter or tag is active, Last Record will move to the last 

record in the filter or tag.  This option is inactive if you are on the last record. 

Find Record 
 

Use this option to find the next occurrence of a specific word or character 

string in the List Pane.  You can search forward or backward in the list.  You 

can search within only one field, or within all fields in the List Pane. 

 

Note:  If you are in the Record Pane when you select this function, you must 

activate a tag set, filter or select multiple records in the list pane.  It will then 

only find the word in that group of records.  You can choose to search all 

fields or only one field. 

Get 
 

Use this option to get a specific record, in order by the current Sort.  For 

example, if the records are sorted by catalog number, Get will prompt you to 

enter a catalog number.  After you enter a number, the program will retrieve 

that record.  If the records are sorted by object name, the program will prompt 

you to enter an object name.  The program will retrieve the first record that 

matches the requested object name.  

Advanced Search 
 

Use this option to perform complex searches for words and phrases that occur 

anywhere in your collection records.  For simple searches, enter the word(s) 

you are looking for in the Quick Search box on the button bar.  See below in 

section D. Button Bar, for more information about Quick Search. 

 

The Advanced Search function in ICMS is one of the most powerful features 

of the program.  It is often the quickest and easiest option for finding records.  
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You can: 

 

• perform Boolean searches using AND, OR, and NOT conditions 

 

• search the current directory, all directories and modules, or specify  

directories and modules you want the system to search 

 

When you use the search results, the selected records are stored in a tag set. 

 

For detailed information on using Advanced Search, see Chapter 7, Section I. 

Advanced Filter Use this option to limit the visible data to records that match specific field 

values that you define.  For each field, you can choose to find any records that: 

 

• start with your value 

 

• are equal to (the same as) your value 

 

• are not equal to (different than) your value 

 

• are less than or equal to (below) your value 

 

• are greater than or equal to (above) your value 

 

• contain the same character string as your value 

 

• are between a range of values 

 

• are blank, or are not blank 

 You can save a filter for later use.  You can select fields to include in the list 

view and select the fields to sort by when using the filter. 

 

For more information on Advanced Filter, see Chapter 7, Section II. 

Deactivate Filter Use this option to deactivate an active filter.  Your visible data will no longer 

be limited to records that match the filter. 

Tag Set Management Use this option to manage tag sets.  Tag sets are sub-sets of records grouped 

together for easy reference. 

 

You will create most tag sets by using Quick Search, Advanced Search, and 

the menu options below.  Use Tag Set Management to view the details of tag 

sets, such as who created them, when they were created, and how many 

records they contain.   

 

For more information on Tag Sets, refer to Chapter 7, Section III. 

 Tag sets are static.  They reflect the content of the database at the time you 

created the tag set.  New records added to the database after you create a tag 

set will not automatically appear in the tag set. 

 
Activate a Tag Set 

 

Use this option to select an existing tag set, and activate it.  Only the records in 

the tag set will be visible. 
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Deactivate Tag Set Use this option to deactivate an active tag set.  Your visible data will no longer 

be limited to records in the tag set. 

Add All Visible to Tag Set Use this option to add all visible records to an existing tag set, or to create a 

new tag set that includes all visible records. 

Add Selected Item(s) to Tag Set Use this option to add selected records to an existing tag set, or to create a new 

tag set that includes only the selected records.  You can select multiple records 

in the List Pane by using the Shift-click and Ctrl-click combinations. 

Remove Selected Item(s) from 
Tag Set 

Use this option to remove the selected record(s) from an active tag set. 

Build a Tag Set Use this option to start building a tag set by using any or all methods that are 

helpful.  While building a tag set, the message “Building: Your Tag Set” will 

appear in the status bar at the bottom of the screen.  You can use any of the 

options described above for adding records to the tag set.  When you’ve added 

all the records you want to the tag set, choose Build Tag Set again to finish. 

Create Tag Set of Random 
Records 

Use this option to create a tag set of randomly selected records.  You can 

choose the number of records to include in the tag set, or a percentage of the 

total number of records. 

Reports Use this option to: 

 

• run all the required (and many of the optional) DOI and Bureau forms, 

and NPS forms from the NPS Museum Handbook, Part II (MH-II) 

 

• create new report formats using the Proficio Report Designer 

 

• use the Quick Report feature to easily create and run reports on your data 

 

Note:  Proficio Report Designer can produce elaborate report formats.  See 

Chapter 5, Section V, Proficio Reports.    

 

For more information on running existing reports and creating quick reports, 

read Chapter 5, Printing and Reports. 

Full View Use this option to open the Full View window.  Full View lets you see all the 

data in all the fields for a record, in one window.  You can print the contents of 

the window, or save it as a file.  See Chapter 5, Printing and Reports. 

XML Export Collections module only.  Use this option to export records to an RTF, SGML 

or XML format using a corresponding RTF, SGML or XML template.  You 

must have an existing custom template to use this feature.  Contact 

Re:discovery Software Inc for information on creating custom templates. 

Finding Aid/SGML Archives module only.  The Finding Aid option in the Archives module has 

been superseded by the new Finding Aid reports available in Proficio Reports.  

See Chapter 5, Printing and Reports.  Note:  The old legacy Finding Aid RTF 

templates are still available under this feature but do not reflect the current 

format or updates for ICMS. 
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7. What options appear under 
Tools on the menu bar? 

The Tools menu includes options for managing your ICMS system.  You can 

setup a User ID for new users, create and delete data directories, access the 

Lexicon module, convert image files, and configure the system options. 

 

Note: Most options on the Tools menu are security-controlled.  You must have 

System Administrator rights.  For more information on security rights, read 

Chapter 9, Section VI. 

Spell Check Use this option to check the spelling of words in a record.  You can check 

spelling on one or multiple records.  You can check the spelling in all data 

fields or only in selected data fields.  For more information about Spell Check, 

see Section K, questions 7, 8 and 9 below and Chapter 6, Section II. 

Lexicon Use this option to view and edit the hierarchy of established terms in the 

lexicons included with ICMS.  

  

Lexicons included with ICMS are: 

 

• Nomenclature 3.0 for Museum Cataloging: Third edition of Robert G. 

Chenhall’s System for Classifying Man-Made Objects (including NPS 

additions) 

 

• NPS Classification Terms 

 

• Art and Architecture Thesaurus (AAT) 

 

• NPS Hierarchical Classification Outline (HCO) 

 

You can also create unit lexicons for your own use.  For more information on 

lexicons and how to use them, read Appendix E: Lexicons. 

 

If you have a need to use other lexicons, such as the Library of Congress 

Subject Headings, you may want to add those to your system.  To add other 

lexicons to your system, please contact Re:discovery Software Inc.  Refer to 

Appendix K: Support for contact information. 

Public Search Use this option to start public search for a selected directory.  You must select 

the directory name only in the Navigation Pane for this option to be active.  

See Appendix D for more information on the setup and use of public search. 

Reclassify and Sweep Words Use this option to start the Reclassify and Sweep functions.  These functions 

keep the program’s word search index up to date.  You will use this function 

only if you have detected a problem with Word Search results.  For more 

information on Reclassify and Sweep, and to see the list of excluded terms, see 

Chapter 9, Tools, Section I. 

Words to Exclude from Word 
Search 

Use this option to define the list of words that searches should ignore, such as 

A, AN, AND, THE, THESE, etc.  Searches are more efficient when they 

ignore commonly occurring words.  You can also remove a word from the 

exclusion list, if you need searches to find that word.  For more information on 

excluding words from search, see Chapter 7, Section I.E. 

Image Conversion Use this option to convert digital image files from one format to another.  You 

can also use it to change the size (resolution) of an image file.  For more 

information on image conversion, see Appendix G: Imaging and Multimedia. 
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Image Count Use this option to count the number of images attached to records in a 

specified directory and produce a report based on that information.  See 

Chapter 5, Section I for more information on the Image Count report. 

Create New Directory Use this option to create a new data directory, such as a temporary cultural 

resources catalog directory for volunteer data entry staff.  You can create new 

directories for cultural resources, natural history, archives, and item level 

archives.  For more information on creating a directory, see Chapter 9, Section 

IV. 

Delete a Directory Use this option to delete an existing data directory that you don’t need.  When 

you delete a directory, you delete all the catalog records and related data.  The 

records will no longer be available in ICMS.  For more information on 

deleting a directory, see Chapter 9, Section V. 

Autosave Use this option to view records that have been saved in the temporary autosave 

location due to a power outage or other unexpected system shutdown while 

you were adding, copying or modifying a record.  You can restore the records, 

compare with existing records or clear them from autosave.  See Chapter 9, 

Section VIII, for more information on Autosave. 

User Security Use this option to create a User ID and set a password for each person who 

needs to use ICMS.  For more information on security rights, read Chapter 9, 

Section VI. 

System Options Use this option to configure certain aspects of your ICMS system.  For 

example, you can tell the system which directories need to share data.  You 

can also tell the system where your digital image files are stored.  For more 

information on System Options, see Chapter 9, Section VII. 

Fiscal Year Summary Report Use this option to run the fiscal year summary report.  This report is the same 

report run by the NPS National Catalog.  It provides catalog record and 

accession counts, catalog numbers and accession numbers used, missing or 

duplicate catalog numbers, etc.  See Chapter 5, Section I.C. for information on 

the fiscal year summary report. 

Catalog Comparison Use this option to compare catalog record data between two directories.  See 

Chapter 8, Section VI. 

Global Record Count Use this option to obtain record, item count, quantity and discipline totals for 

all directories in your system.  See Chapter 5, Section I.C. 

Identify Duplicate Records Use this option to produce a report identifying duplicate records from any 

table within a directory or directories based on the unique identifier for each 

table (e.g., catalog number, accession number, loan number, etc.)  See Chapter 

5, Section I for more information on the Identify Duplicate Records report. 

Identify Invalid Flex Dates Use this option to identify records that have invalid entries in the flex date 

fields (e.g., Manufacturing Date or Collection Date).  Since invalid entries in 

Flexible Date fields may cause the records to not be sorted correctly or 

properly indexed for word search, they should be corrected wherever possible.  

See Chapter 5, Printing and Reports, Section I for more information on the 

Identify Invalid Flex Dates report. 
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Analyze Sweep Tables Use this option to analyze the word search indexes when word search is not 

finding results for any searches.  It will report potentially problematic symbols 

or characters in your data that may have been imported or pasted into a field.  

See Chapter 9, Section I.D. for more information on the Anaylze Sweep 

Tables function. 

ITIS Tables Update Use this option to apply updates to the Natural History taxonomy lexicon.  See 

Appendix E, Section E, for information on the ITIS lexicon. 

Software Updates Use this option to apply program updates that may be provided periodically.  

See Chapter 9, Section X. 

8. What options appear under 
Help on the menu bar? 

The Help menu includes options for accessing the on-line help system. 

System Help Use this option to access the on-line system help.  The content of the system help 

is the same as the Re:discovery User Manual. 

About Re:discovery 
 

This option includes information on contacting Re:discovery Software, Inc. 

D. Button Bar  

1. What is the purpose of the 
button bar across the top of 
the screen? 

The button bar contains icons that represent some of the most frequently used 

functions.  It is located directly below the menu bar.  The button bar provides 

quick access to functions.   

 

Note:  A function works the same from either the menu bar or the button bar. 

2. How do I access the 
functions on the button bar? 

Hold your mouse pointer over the icon to see the name of the function.  Single-

click an icon to use that function. 

3. What do the icons on the 
button bar mean? 

The following pages list the icons on the button bar, and explain their purpose.  

The pages are designed to be pulled from this manual, copied, and posted near 

your computer for easy reference. 
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The Button Bar 
 

 Back  Use this option to go back to a screen you viewed previously, such as another 

module, directory, or associated module. 

 Forward  Use this option to go forward to a screen you viewed previously, such as another 

module, directory, or associated module.  This option is only active after you have 

used the Back option. 

 
Navigation 
Pane 

 Use this option to close or open the Navigation Pane.  The navigation pane is 

on the left side of the screen.  It includes the Navigator “tree”, Field Help, and 

Quick Actions.  You can use the navigator to go to associated modules such as 

Accessions, Exhibits, and Loans. 

 
List Pane  Use this option to close or open the List Pane.  The list pane is above the 

record pane.  It shows the list of visible records in the current module. 

 
Record Pane  Use this option to close or open the Record Pane.  The record pane shows the 

data you are currently working with. 

  Sort 

Use this option to organize your records.  You can put your records in order by 

Catalog Number, Location, Object Name, etc.  The default sort is by catalog 

number. 

 
First Record F6 Use this option to go to the first record in the visible data, in order by the 

current Sort.  If a filter or tag is active, this option will move to the first record 

in the filter or tag.  This button is inactive if you are on the first record. 

 
Previous 
Record 

F3 Use this option to go to the previous record in your visible data, in order by the 

current Sort.  The previous record is the record directly before the one 

currently on the screen.  If a filter or tag is active, Previous Record will move 

to the previous record in that filter or tag.  This button is inactive if you are on 

the first record. 

 
Next Record F4 Use this option to go to the next record in your visible data, in order by the 

current Sort.  The next record is the record directly after the one currently on 

the screen.  If a filter or tag is active, Next Record will move to the next record 

in the filter or tag.  This button is inactive if you are on the last record. 

 
Last Record F7 Use this option to go to the last record in the visible data, in order by the 

current Sort.  If a filter or tag is active, Last Record will move to the last 

record in the filter or tag.  This button is inactive if you are on the last record. 

 
Get F8 Use this option to get a specific record, in order by the current Sort.  For 

example, if the records are sorted by catalog number, Get will prompt you to 

enter a catalog number.  

 
Find Record Ctrl-F Use this option to find the next occurrence of a specific word or character 

string in the List Pane.  You can search forward or backward in the list.  You 

can search within only one field, or within all fields in the List Pane. 

 Quick Search 
Use this option to enter the word(s) you are looking for in the Quick Search 

box, then press Enter or click the blue arrow to perform the search. 

 
Advanced 
Search 

Alt-8 Use this option to perform complex searches for words and phrases that occur 

anywhere in your collection records.  Advanced Search is one of the most 

powerful features of the program.  It is often the quickest and easiest option for 

finding records.  You can: 

 

• perform Boolean searches using AND, OR, and NOT conditions 

• search the current directory, all directories and modules, or specify  

directories and modules you want the system to search 

 

For detailed information on using Advanced Search, see Chapter 7, Finding 

and Grouping Records. 

 
Advanced 
Filter 

 Use this option to limit the visible data to records that match specific field 

values that you define.  You can save a filter for later use.  You can select 

fields to include in the list view and select the fields to sort by when using the 

filter.  For more information on Advanced Filter, see Chapter 7, Finding and 

Grouping Records. 
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Deactivate 
Filter 

 Use this option to deactivate an active filter.  Your visible data will no longer 

be limited to records that match the filter. 

 
Activate a 
Tag Set 

 Use this option to select an existing tag set, and activate it.  Only the records in 

the tag set will be visible. 

 
Deactivate 
Tag Set 

 Use this option to deactivate an active tag set.  Your visible data will no longer 

be limited to records in the tag set. 

 
Add New 
Record 

F9 Use this option to create a new record.  Add creates a new blank record and 

places you in Add Mode.  In the Collections module, the last acronym that was 

used for the catalog and accession number will appear on the record.  After 

you save the new record, the program returns to View Mode.  For more 

information on adding or modifying catalog records, see Chapter 2, 

Cataloging. 

 
Modify This 
Record 

F10 Use this option to modify the contents of the record currently on the screen.  

You may change previously entered data or enter new information.  This 

option places you in Modify Mode. 

 
Copy This 
Record 

 This option allows you to make an exact copy of the record currently displayed 

on the screen and then to edit the new record.  You cannot save the copy 

unless you change the catalog number.  This option places you in Copy Mode, 

so that you can modify the catalog number and any other fields. 

 
Refresh  Use this option to refresh the screen if other users have modified the record 

since you began to view it. 

 
Quick Report  Use this option to use the Quick Report feature to easily create and run reports 

on your data.  For more information on creating quick reports, read Chapter 5, 

Printing and Reports. 

 
Proficio 
Reports 

 Use this option to run all the required DOI, Bureau, and NPS forms and to 

create new report formats using the Proficio Report Designer.  For more 

information on running existing reports and creating reports, read Chapter 5, 

Printing and Reports. 

 
Full View  Use this option to open the Full View window.  Full View lets you see all the 

data in all the fields for a record, in one window.  You can print the contents of 

the window, or save it as a file.  See Chapter 5, Printing and Reports. 

 
Print Preview  Use this option to preview what will print with the Print List option. 

 
Print List  Use this option to print the list of visible data.  The fields and records included 

in the printout will match those in the List Pane.  See Chapter 5, Printing and 

Reports. 

 
Lexicon  Use this option to view and edit the hierarchy of established terms in the 

lexicons included with ICMS.  You can also create unit lexicons for your own 

use.  For more information on lexicons and how to use them, read Appendix E: 

Lexicons. 

 
System Help F1 Use this option to access the on-line system help.  The content of the system help 

is the same as the Re:discovery User Manual. 

 
View 
Hierarchical 
Browse 

 Archives module only.  Use this option to open the Hierarchical Browse 

window.  The window displays Collection, Series, File Unit, and Item level 

records in a color-coded hierarchy.  The window can remain open while you 

work with records.  See Appendix F, Archives Module for more information. 

 
Use 
Hierarchical 
Ranges 

 Archives module only.  Use this option to activate/deactivate the use of 

hierarchical ranges.  When active, this option limits the visible data to the 

records within the same range as the current Collection, Series, or File Unit.  

When inactive, all records are visible.  See Appendix F, Archives Module for 

more information. 

 
Create MARC 
record(s) 

 Archives module only.  Use this option to create a MARC record from the 

current data on the Collection record.  Only available on the Collection level 

record.  See Appendix F, Archives Module for more information. 
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E. Function Keys 
 

 

1. Can I use Function keys as 
shortcut keys? 

Yes.  The table below lists the function keys available in Re:discovery.  In 

addition, you can make your own shortcut keys using the macro function. 

 

F1   System Help   
 

Access the on-line system help.  The content of the system help is the same as the 

Re:discovery User Manual. 

F2   Save Record 
 

Save the record you are currently editing in Add, Modify, or Copy mode. 

F3   Previous 
Record   

 
Go to the previous record in your visible data, in order by the current Sort.  If a 

filter or tag is active, Previous Record will move to the previous record in that 

filter or tag. 

F4   Next Record   
 

Go to the next record in your visible data, in order by the current Sort.  If a 

filter or tag is active, Next Record will move to the next record in the filter or 

tag. 

F5   Browse 
Authority Table 

 In Add, Modify, or Copy modes, browse and select a term from an authority 

table. 

F6   First Record   
 

Go to the first record in the visible data, in order by the current Sort.  If a filter 

or tag is active, this option will move to the first record in the filter or tag. 

F7   Last Record   
 

Go to the last record in the visible data, in order by the current Sort.  If a filter 

or tag is active, Last Record will move to the last record in the filter or tag. 

F8   Get 
 

Get a specific record, in order by the current Sort.  For example, if the records 

are sorted by catalog number, Get will prompt you to enter a catalog number.  

F9   Add New 
Record 

 
Create a new record.  Add creates a new blank record and places you in Add 

Mode.  After you save the new record, the program returns to Menu Mode. 

F10   Modify This 
Record   

 
Modify the contents of the record currently on the screen.  You may change 

previously entered data or enter new information.  This option places you in 

Modify Mode. 

F11 Field List  Open the list of fields in Advanced Search to select a field to limit the search. 

Play the active Macro in edit modes. 

F12   Expand Field  Open the field in a larger window, so you can see all the text.  Use for any 

memo, formatted memo, repeating formatted memo, or stacked table field. 

Alt-8   Advanced 
Search   

 
Perform complex searches for words and phrases that occur anywhere in your 

collection records.  Advanced Search is one of the most powerful features of 

the program.  It is often the quickest and easiest option for finding records. 

Alt-F4     Exit 
 

Exit ICMS. 

Ctrl-A   Select All    Select all the text in a field, so that you can cut or copy it. 

Ctrl-C     Copy 
 

Copy the selected text, so you can paste it in another location. 

Ctrl-F   Find Record    Find the next occurrence of a specific word or character string in the List Pane. 

Ctrl-N   Next Page  Go to the next page of a multi-page catalog record. 

Ctrl-R   Previous Page  Go to the previous page of a multi-page catalog record. 

Ctrl-V     Paste  Paste the text you’ve copied to the Windows clipboard.  Note: You must be in 

Add, Modify, or Copy mode to add text to a record. 

Ctrl-X   Cut 
 

Cut the selected text from a record.  Note: You must be in Add, Modify, or 

Copy mode to remove text from a record.   

Ctrl-Z   Undo 
 

Undo the last word you typed in a record. 

Ctrl-Insert Character Map  Open the Windows Character Map to insert special characters in your data. 

Ctrl-F5   Edit Authority 
Table 

 Open a user-built authority table to add new terms or edit existing terms. 

Ctrl-Del Delete Term  Delete a term from a field controlled by an authority table. 

Shift-F10 Right-click 
Menu 

 Open the right-click menu for a field when in Add, Modify or Copy mode. 
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F. Modes of Operation  

 ICMS has five different modes of operation.  The current mode appears on the 

status bar in the lower right corner of the screen. 

1. Browse Mode Browse Mode is active when you are using the Home Page or Navigator to 

select the directory or module where you want to work.  The system will 

remain in Browse Mode until you select a data set to work with. 

2. View Mode View Mode is active when you view a data record.  It is the default mode.  In 

View Mode, you can select and view records, and run reports.  You cannot 

change or add data. 

3. Modify Mode Modify Mode is active when you are modifying an existing record.  When you 

modify a record, a separate window opens and the status bar will say Modify 

Mode.  All the fields on the screen are active and the data can be edited. 

4. Add Mode Add Mode is active when you are adding new records.  When you add a new 

record, a separate window opens and the status bar will say Add Mode.  In 

Add Mode the screens contain empty fields.  All the fields on the screen are 

active so that you can add data. 

5. Copy Mode Copy Mode is active when you copy the current record to create a new record.  

When you copy a new record, a separate window opens and the status bar will 

say Copy Mode.  In Copy Mode the screens contain the same data as the 

record you copied.  You must change at least the Catalog Number in order to 

save the record. 

G. Visible Data  

1. What is “visible data”? The active data in ICMS are called visible data.  Visible data are the data that 

the program sees and acts upon on commands from the user.  Visible data 

include all the records in an active tag or filter, and all the records that you can 

scroll through in the List Pane. 

2. Aren’t all my data visible? No.  Visible data can be the entire database or a subset of data that you have 

selected.  Frequently, you will want to work with subsets of your data.  For 

example, you may want to work with only the biology records or the books in 

the collection. 

3. How do I create subsets of 
data? 

You can create a data subset by using the search, filter or tag functions.  These 

functions are explained in depth in Chapter 7, Finding and Grouping Records. 

4. Why is it important to be 
aware of visible data? 

When running reports or updating groups of records, you need to be aware of 

the currently visible data.  You can print reports that include the current 

record, or all visible records.  You can update the current record, or all visible 

records.  Here's how the process works: 

 

• you create a subset of data, for example, the records for a group of objects 

on exhibit 

 

• you use the Mass Supplemental Update command to change the data, for 

example, the Object Status, Status Date, and Location fields 
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 • the program will only make the change on the data that are visible to the 

program, that is, the records for the objects on exhibit  

 

• the change does not affect the other records in the database 

5. How do I know what data 
are visible? 

The status bar at the bottom of the screen tells you the visible data.  It tells you 

whether a "filter" or "tag" is active.   Filters and tags limit the visible data.  If 

these words do not appear, all the records are visible. 

H. Right-click Menus  

1. What are right-click menus? Right-click menus are short lists of common or frequently used functions 

specific to a field or list item.  They show the name of the function as well as 

the shortcut key for that function if available.  The majority of these functions 

can also be found in the menus on the Menu Bar. 

2. How do I get to the right-
click menus? 

Using the mouse, position the mouse pointer in a field, over an item in the list 

or navigator, or over an image, then click using the right button on the mouse. 

3. Why are some options on 
the right-click menu grayed 
out? 

Many of the options depend on the mode you are in or what is selected.  For 

example, the spell check options are only available when you are in add, 

modify or copy mode.  The copy option is only available if you have text 

highlighted. 

4. What are the right-click 
menu options for fields? 

There are two right-click menus associated with data entry fields in every 

module and associated module.  The menu you see is determined by the field 

type. 

 The right-click menu for memo, straight entry, formatted memo, repeating 

formatted memo, date and numeric fields looks like this: 

 

 
 

Note:  Options marked with ‘*’ are only available on the right-click menu or 

by using the shortcut key associated with that option. 

*Zoom Expands the current field to view more text, subfields or further data entry 

windows.  
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Browse Lexicon Available only on memo fields in add, modify or copy modes. Opens the 

lexicon window where you can search for and view the hierarchy of terms in 

the AAT, Nomenclature 3.0, HCO and unit lexicons.  For more information on 

how to use the Lexicon, see Appendix E. 

Check Spelling Checks the spelling for the current field.  You must be in add, modify or copy 

mode. 

Check Spelling for All Fields Checks the spelling for all fields in the current record.  You must be in add, 

modify or copy mode. 

*Launch to Windows If you have a file path in the selected field, you can use this option to start the 

program that created the file and view the contents of that file.  This is very 

useful if you have reports from conservators or researchers about the object 

but do not want to copy the entire contents of the report into the catalog 

record.  Use the Copy Filename – Browse function described below to copy 

external file paths. 

 

Note:  The file path must be the only text in the field. 

Launch email Starts your email application. 

*Properties Displays the field properties for the current field. 

Cut Use this function to delete highlighted text in the field.  You must have text 

highlighted and be in add, modify or copy mode to use this function. 

Copy Use this option to copy the highlighted text, so you can paste it in another 

location.  Copied text is held in the Windows “clipboard”.  You can paste the 

text into a Word document, email, etc. 

Paste Use this option to paste text from the clipboard to the current field.  You must 

have copied text to your computer’s clipboard first and be in add, modify or 

copy mode to use this option. 

Copy/Append Use this option to copy highlighted text from more than one field.  After 

selecting and copying one piece of text, select another piece of text and use 

Copy/Append.  Both pieces of text are held in the Windows clipboard, 

waiting for you to paste them.   

*Copy Filename – Browse Use this option to open a Windows dialog box to select an external file that 

you want to paste a reference to in the ICMS field.  This will copy the file 

path to the clipboard.  You can then use the paste option to insert the file path 

in the selected field.  You must be in add, modify or copy mode to paste the 

file path. 

 

Example:   c:\reports\consreport.doc 

*Paste from Last Record This option will paste the contents from the same field of the previous record 

you were viewing into the same field of the current record.  You must be in 

add or modify to use this option. 
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*Launch OCR Software This option starts your Optical Character Recognition Software.  OCR 

software scans documents and converts them to editable electronic file 

formats.  You must be in add, modify or copy to use this option.  See 

Appendix B, Installation and Setup for information on connecting to OCR 

software. 

*Extended Character Set Use this option to paste accented characters or symbols not available on the 

keyboard in the text.  

 

 • In the Character Map window, select a Font if necessary and then click 

on a character in the grid. 

• Click Select to paste the character in the Characters to copy field.  You 

can choose more than one character by clicking on a different character 

and then click Select again.  Both characters will be copied. 

• Click Copy to paste the selected characters on the Windows clipboard. 

• You can leave the Character Map window open if desired so that you can 

use other characters, or click the X to close the Character Map window. 

• In the catalog record field, press <Ctrl><V> to paste the character in the 

field.  Or right-click and choose paste on the right-click menu.  The 

character will be pasted in the location of the cursor. 

 For single authority table and stacked authority table fields, the right-click 

menu looks like this: 
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There are two differences on this menu, Launch OCR Software has been 

removed and Browse Lexicon is replaced by: 

*Browse Authority Table Opens the authority table associated with the selected field so that you can 

view, add, delete or modify terms in the table.  To add, delete or modify terms 

in the table, you must have the appropriate security rights. 

5. What are the options on the 
right-click menu for Images? 

On the Images page of a record (available in collections, archives and some 

associated modules), you can right-click on any image and see the following 

right-click menu. 

 

 

Film Strip This option changes the Images layout to the Film Strip style which shows the 

thumbnails in a column on the left and a single enlarged image on the right. 

Thumbnails This option changes the Images layout to show only the thumbnails of images 

attached to the catalog record. 

Slide Show This option changes the Images layout to show only a single enlarged image.  

Use the forward and back arrows on the button bar in the Images page to view 

additional images attached to the record. 

Import Image Files This option opens an Open window for you to select image file(s) to attach to 

the current record.  See Appendix G: Imaging and Multimedia for further 

information on attaching images. 

Import Image Folder This option opens a Browse for Folder navigation window for you to select a 

folder of images to attach to the current record.  This will attach all image 

files inside the selected folder to the current record. 

Copy Image(s) To This option opens a Browse for Folder navigation window for you to select a 

folder to copy the selected image(s).  This makes a copy of the image file(s) 

and pastes them in the selected folder.  You can select multiple images to 

copy at the same time by holding the <Ctrl> key and clicking on each image. 

Delete Selected Image(s) This option deletes the selected image(s) from the current record.  To select 

more than one image at a time, hold the <Ctrl> key and click on multiple 

images. 
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Zoom Image This option opens the Picture Zoomer window to allow you to view the full 

image and zoom in or out. 

Print Using Best Fit This option prints the selected image sizing it to fit on the page.  A Preview 

window opens allowing you to view the page before printing. 

Print Actual Size This option prints the image using its true size.  A Preview window opens 

allowing you to view the page before printing. 

Print Contact Sheet This option prints all the thumbnails for a record on one or more pages 

depending on how many images are attached to the record.  Multiple 

thumbnails are printed on each page.  A Preview window opens allowing you 

to view the page(s) before printing. 

Image Properties This option opens the Picture Properties window showing the title, 

description and file information (resolution, size, location, etc.) for the 

selected image.  It also shows you the Exchangeable Image File Format (Exif) 

information if available (e.g., camera used to create the image, settings, etc.). 

6. What are the options on the 
right-click menu for a row in 
the List Pane? 

When you right-click on a row in the List Pane, you will see this right-click 

menu for collections and associated modules.  All of these options are 

available on the button bar and menu bar. 

 

 
 

See Section C above for information on how these options work. 

 In the Archives module, the right-click menu in the List Pane for Collections, 

Series, File Unit and Item records has 2 additional options related to archives: 
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For information on how to use the View Hierarchical Browse and Use 

Hierarchical Ranges options, see Section J below and Appendix F.  These 

options are also available on the button bar and menu bar. 

7. What are the options on the 
right-click menu for a record 
in the Supplemental list? 

On the Supplemental Information page of the catalog or archive record, you 

can right-click on a supplemental record in the list and see this right-click 

menu.  All of these options are also available on the Supplemental 

Information page above the list. 

 

Edit Row This option opens the supplemental record in a new window in Modify mode. 

Delete Row This option deletes the supplemental record from the catalog record.  Click 

Yes to delete the supplemental record when prompted. 

View Row This option opens the supplemental record in a new window in View mode. 

8. What are the options on the 
right-click menu for the 
column headers in the List 
Pane, Supplemental list,  
archives sub-records list and 
other lists with column 
headers? 

In the List Pane, Supplemental page, sub-records lists for archival records and 

most other lists with column headers in the program, when you right-click on 

one of the column headers, you will see this right-click menu. 
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Note:  Options marked with ‘*’ are only available on the right-click menu or 

by using the shortcut key associated with that option. 

*Sort Ascending Sorts the records in the List Pane or Supplemental list by the current column 

in ascending order (smallest to largest or A to Z).  An arrow appears in the 

column header indicating the direction of the sort.   

 

Note: You can also click on the column header to sort the list. 

*Sort Descending Sorts the records in the List Pane or Supplemental list by the current column 

in descending order (largest to smallest or Z to A).  An arrow appears in the 

column header indicating the direction of the sort.   

 

Note:  By clicking on the column header again, you can reverse the sort order.  

*Clear Sorting Cancels the sort on the selected column.  This option is available only on the 

column that is currently used as the sort in the List Pane.  When you clear the 

sort on the column, the order reverts to the sort order indicated on the button 

bar. 

*Group By This Column This option groups the records in the List Pane or Supplemental list by the 

unique entries in the selected field.    

 

Note: You can also drag the column header to the area above the list.   This 

area is called the Group By Box. 

 

Notice that the column disappears from the List Pane or Supplemental list and 

you will see the unique entries from that field preceded by a +.  Each row also 

indicates how many records are contained in that group.  Click on a + to 

expand a unique entry and see the individual records. 

 

 

 You can group by more than one field by selecting another column header 

and dragging it to the Group By Box or right-clicking and choosing Group By 

This Column.  This gives you a secondary grouping inside the main grouping.  

You can create as many sub groupings as you have column headers less one if 

desired (you must leave at least one column in the List Pane). 
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 If you right-click on a column header while it is in the Group By Box, you 

will see a similar right-click menu with 4 additional options for expanding, 

collapsing and sorting the groupings. 

 

 

*Full Expand This option expands all entries in the List Pane or Supplemental list so you 

can see all the records under each group without clicking the + in front of 

each row. 

*Full Collapse This option collapses all groups back down to the main group. 

*Sort by Summary This option allows you to sort the grouping by record id either in ascending or 

descending order.  If you select one of these sorting options, when you right 

click again on the column header in the Group By Box, an option to Clear 

Summary Sorting will appear to return to the regular sort on that column. 

*UnGroup This option removes the selected column header from the Group By Box and 

returns it to the List Pane.  The records are no longer group by this column. 

*Hide (Show) Group By Box This option opens and closes the area above the List Pane or Supplemental 

list.  If you do not see the Group By Box, right-click on a column header in 

the list and select Show Group By Box. 

*Remove This Column This option will remove the selected column from the List Pane or 

Supplemental List.  Note: the removed column will reappear when you 

reselect the sort or exit and log back into the program. 

*Best Fit This option sizes the selected column to the widest entry in that field.  
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Note:  To adjust the width of any column manually, use the mouse to drag the 

right edge of the column header to the left or right.  You should notice the 

mouse pointer turn to a right/left arrow when you hover over the edge of a 

column header. 

*Best Fit (all columns) This option sizes all the columns in the List Pane or Supplemental list to 

optimal widths so that all columns in the list are viewable. 

*Filter Editor This option opens the custom quick filter editor window.  This is the same as 

choosing (custom) on the quick filter pull down menu of a column header.  

This option only appears if no quick filter is currently active.  If a quick filter 

is active, use the Edit Filter button on the Quick Filter indicator bar below the 

List Pane. See Chapter 7, Section II for further information on quick filters. 

*Clear Filter This option cancels any quick filter you may have set on that column in the 

List Pane or other lists.  It only appears on the right click menu if you have a 

quick filter activated on that column in the list. 

 

Note:  This option does not cancel any built in filters or advanced filters you 

may have set.  It only cancels quick filters set using the column header pull 

down list. 

*Show Find Panel This option opens a panel above the List Pane where you can enter a word or 

string of characters to find in the fields in the List Pane.  This limits the 

visible data to only those records that contain that word or character string 

within any field in the List Pane.  (This option is not available if you have a 

quick filter active already.) 

 

For example, enter ‘point’ and click the Find button to limit the list to those 

records that have that word in one of the fields in the List Pane.  Note that it 

will highlight the word in the fields. 

 

 
 

Click Clear to return the list to all records. 

 

To turn off the Find Panel, click the X in front of the entry box, or right click 

a column header and choose Hide Find Panel. 

*Show Auto Filter Row This option adds an editable row just below the column headers in the List 

Pane or Supplemental List.  You can use this row to type a word or character 

string on which to filter.  This will create a “Starts with” filter for that 

column.  (This option is not available if you have a quick filter active 

already.) 

 

For example, with this auto filter row activated, enter ‘abr’ in the object 

column to find all records where the object name begins with ‘abr’.  (It is not 

case sensitive.) 
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To turn off the auto filter row, right click a column header and choose Hide 

Auto Filter Row. 

9. What are the options on the 
Hierarchical Browse View 
right-click menu in the 
archives module? 

In the Archives Hierarchical Browse window, you can right-click on any row 

to see these right-click menu options: 

 

 
 

All of these options are available on the button bar and menus in the 

hierarchical browse window.  See Section J below and Appendix F: Archives 

Module, for information on how to use these options. 

10. What are the options on the 
Saved filter right-click 
menu? 

In the Navigation Pane, you can right-click on a saved filter and see the 

following filter options: 

 

 
 

The options here allow you to set, modify and delete the selected filter.  For 

more information on creating and activating filters, see Chapter 7, Section II. 

Apply filter Sets the selected filter on the visible data.  The List Pane fields may change to 

fields specified in the filter. 

Apply filter, clear tag set Deactivates the current tag set and sets the selected filter. 

Apply filter, keep list view Sets the selected filter and maintains the List Pane fields. 

Apply filter, clear tag set, keep 
list view 

Deactivates the current tag set and sets the selected filter without changing the 

fields in the List Pane. 

 

Modify filter Opens the Advanced Filter window with the selected filter properties 

displayed for you to modify, activate and save. 
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Delete filter Deletes the selected filter.  Note: you cannot delete built-in filters. 

 If you right-click on My Filters or Shared Filters, you can refresh the filter list 

or create a new advanced filter. 

 

 

11. What are the options on the 
Tag Set right-click menu? 

In the Navigation Pane, you can right-click on a tag set and see the following 

tag set options: 

 

 

Activate tag set Activate the selected tag set. 

Activate tag set, clear filter If a filter is currently active, you can cancel the filter before activating the tag 

set. 

Modify tag set Opens the Tag Set Manager window.  Here you can change the properties of a 

tag set such as the name or description. 

Delete tag set Deletes the selected tag set. 

12. What are the options on the 
Quick Entry right-click 
menu? 

In the Navigation Pane, you can right-click on a quick entry format and see 

the following tag set options: 

 

 

Modify Records with Quick Entry Activates the Quick Entry format selected for you to modify records. 

View Records with Quick Entry Activates the Quick Entry format in view mode. 

Modify Quick Entry Format Opens the Quick Entry Manager window where you can update the format 

such as change or add columns. 

Delete Quick Entry Format Deletes the selected quick entry format. 

 If you right-click on Shared Quick Entry Format or My Quick Entry Format 

you can refresh the quick entry list or create a new quick entry format. 
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I. Catalog Record Screens  

1. What are the names on the 
tabs at the top of the catalog 
record? 

The tab names tell you what part of the record you are looking at.  There are 

five parts to a record: Object Information, Supplemental Information, Images, 

Multimedia and Associations. 

 

Object Information is divided into five categories: 

 

• Cultural Resources categories are: Registration, Catalog, Provenience/ 

Manufacture, discipline, and Unit 

 

• Natural History categories are: Registration, Catalog, Collection Site, 

discipline, and Unit 

 

 
 

Note: Archives records (see Section J below) and associated module records 

look different and have different parts than Collections Module catalog 

records.  Refer to Chapter 4, Associated Modules, and Appendix F: Archives 

Module, to learn about those types of records. 

2. Why are some of the tabs 
inactive? 

Entries in the Class 1 field (Class 4 field for archives) determine the active tab 

and the fields on the discipline-specific screen.  There are four discipline 

screens in the Cultural Resources Module:  Archeology, History, Ethnology 

and Archival/Manuscript Collections.  There are three discipline screens in the 

Natural History Module:  Biology, Geology and Paleontology.  For specific 

field by field help for cataloging objects using the discipline-specific screens, 

read Chapter 2, Cataloging. 

3. How do I move between 
pages within a catalog 
record? 

To move from page to page: 

 

• press the Ctrl-N (Next Page) and Ctrl-R (Previous Page) keys, or 

 

• go to View on the menu bar and choose Next Page or Previous Page from 

the pull-down menu 

4. How do I move through the 
fields in the catalog record? 

Press the Tab key to move from one field to the next.  Shift-Tab will take you 

back one field.  You can also move the mouse pointer to the field and single-

click. 
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5. What is the difference 

between the DOI and NPS 
catalog screens? 

The only difference between DOI and NPS catalog screens is the Catalog # 

and the Accession # fields.  The DOI catalog and accession number fields are 

unformatted.  They allow any numbering format in use by the various bureaus.  

The NPS catalog and accession number fields use a strict 3-part format.   

 

Any DOI bureau except NPS may use the DOI format.  All NPS records 

should be entered using the 3-part NPS format. 

6. What is the difference 
between the ”Save”,  “Save 
and Close” and “Save and 
Add Another” links? 

Use these links to save your work when you are in Add, Modify, or Copy 

modes.  These links do not appear on the screen in View mode. 

 

To save the record but leave the record window open, click the Save link, or press 

the Tab key until Save is highlighted and press the Enter key.  If you have not 

completed all the mandatory fields you will be prompted to save the record as a 

DRAFT RECORD.  You will now be in View mode on the record.   

 

To save the record and close the edit window, click on the Save and Close link, 

or press the Tab key until Save and Close is highlighted, and press the Enter 

key.  If you have not completed all the mandatory fields you will be prompted to 

save the record as a DRAFT RECORD.  The edit window will close. 

 

In Add mode only, click the Save and Add Another link to save the current 

record, and add another record.  A new Add Mode window will open. 

 

Note:  You can enter data and move to the next screen without saving until you 

have completed the record. 

7. What are the User fields on 
the Unit tab? 

ICMS contains several User fields that allow you to enter unit-specific data.  

The Unit page of the catalog record contains 10 User fields.  Most of the 

associated modules also contain User fields on the Extended Information page. 

8. How do I create a unit-
specific field from a User 
field? 

You must have System Administrator security rights to change a User field.  

Refer to Chapter 9, Section VI for information on security rights. 

 

To create a unit-specific field from a User field: 

 

• Right-click the field and choose Properties from the pop-up menu.  The 

Field Properties window opens. 

 

• Enter a new label for the field, and select a field type from the pull-down.  

See Section K below for information on field types. 

 

• Click the Save and Close link to save your changes. 

J. Archive Record Screens  

1. When do I use the Archives 
Module? 

Use the Archives Module to catalog and manage hierarchically organized 

archive or manuscript collections. 

2. What are archival levels? The 4-level archives directory has four hierarchically related levels:  

Collection, Series, File Unit and Item.    
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• The Collection level is the broadest level of description.  Collections may 

be further described in related sub-records such as Series, File Unit and 

Item records.  Collection level records may be transferred from the 

Cultural Resources module (see Chapter 2, II. Cataloging 

Archival/Manuscript Collections). 

 

• The Series level allows for specific sub-divisions of a collection, usually 

by subject.  It may be further described in File Unit and Item records 

related to each series. 

 

• The File Unit level describes the contents of a box, folder or other 

container housing archival documents.  Each File Unit record may be 

described in individual Item records. 

 

• The Item level is used to describe individual documents within a 

collection, such as a single letter or photograph. 

 

Note:  It is not necessary to enter records at every level. For example, a series 

may only have item records without any intermediate file unit records. 

3. How do I view records at 
each archival level? 

To view all records at a specific level: 

 

• In the Navigation Pane, select the archival level in the navigation tree 

directly under the archives directory, or 

 

• On the Archives directory page, double-click the archival level under 

Collections. 

 

 
 

These will load all records for the level you choose. 

4. What are the names on the 
tabs at the top of the 
archives record? 

The tab names tell you what part of the record you are looking at.  There are 5 

main parts to an individual archive record:  Main Information (Collection, 

Series, File Unit or Item); Supplemental Information; Images; Multimedia; 

and Associations.  In addition, there are tabs for Hierarchical Parents and the 

various Sub-Records tabs to show the hierarchical children depending on the 

archival level you are viewing. 
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The first tab is labeled according to the archival level you are viewing and is 

divided into 3 categories: 

 

• Collection, Series, File Unit, or Item Information 

 

• Extended Information 

 

• MARC Information (Collection records only) 

 

 

5. What is the MARC 
Information tab? 

The MARC Information tab is available only for Collection level records.  It 

shows the MARC record that can be created from the archive record.  A 

MARC record is a “MAchine-Readable Cataloging” record used by library 

systems.  See Appendix F: Archives Module for further information about 

MARC records.  MARC Information is optional. 

6. How do I move between 
pages within an archive 
record? 

To move from page to page: 

 

• click the tabs, or 

 

• press the Ctrl-N (Next Page) and Ctrl-R (Previous Page) keys, or 

 

• go to View on the menu bar and choose Next Page or Previous Page from 

the pull-down menu 

7. What is the Hierarchical 
Parents tab? 

Hierarchical Parents shows the records that are related to the current record at 

the levels above.  For example, to view the Series and/or Collection records 

that the Item belongs to, go to the Hierarchical Parents page.  Click on one of 

the parent links to go to that record.  Collection level records have no 

Hierarchical Parents unless it is a subcollection. 

8. What are the Sub-Records 
tabs? 

The Series, File Unit and Item Sub-Records tabs show the related records that 

describe the current record in more detail.  For example, to view the list of 

series records for a particular collection, select the Series Sub-Records tab 

from the Collection record. 
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9. What is the “Use These 
Records” option on the sub-
records tabs? 

“Use These Records” changes the level at which you are currently viewing to 

the sub-record level and loads the listed sub-records into the List Pane and 

Record Pane setting a hierarchical range for only these records.   These 

records will become your visible data. 

 

For example, to use the Series level records of a Collection, choose the Series 

Sub-Records tab and click Use These Records.  These series records will be 

loaded into the List Pane and Record Pane; the level will change to Series; and 

a hierarchical range will be set for the Collection number you were viewing. 

 

 

10. Why are some of the sub-
records tabs missing from 
the Series, File Unit and Item 
records? 

Because of the hierarchical arrangement of the directory, each level will have 

one fewer sub-level in which it can be divided.  A Series record can be 

described in more detail in File Unit and Item sub-records while a File Unit 

record can only be further described in Item sub-records.  An Item record is 

the lowest level and has no sub-records.  Use the Hierarchical Parents tab to 

access the related records above the current level. 
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11. What are hierarchical 

ranges? 
Hierarchical ranges limit the visible data to a specific collection, series, or file 

unit.  Each archive record has a multi-part number beginning with the 

Collection number to identify it as belonging to a specific collection, series 

and/or file unit.  For example, a hierarchical range set on the Item level might 

be a filter for the Collection and Series number to which the group of Item 

records belong. 

 

The Hierarchical Range function is either active or inactive.  You can activate 

or deactivate it on each level separately.  To turn it on or off, click the Use 

Hierarchical Ranges button  on the button bar or go to Record on the menu 

bar and uncheck Use Hierarchical Ranges.  When active the Status Bar 

displays “Hierarchical Range” in the lower left. 

12. How can I view all the 
archive records in a 
hierarchical list? 

To view all levels of archive records arranged hierarchically: 

 

• click the View Hierarchical Browse button  on the button bar, or 

 

• go to Record on the menu bar and choose View Hierarchical Browse. 

 

 

 To expand a level, click on the + symbol in front of it.  Each sub-record is 

indented below its immediate parent. 

 

There are several features available from the hierarchical browse.  These can 

be accessed from the button bar or the right-click menu. 

 

• You can view and modify a single record from this list by double clicking 

the record to open it, or right-click and select View Record or Modify 

Record  on the pop-up menu.  The record will open in a separate 

window. 
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• You can add records from this list view.  Right-click on a record and 

choose to Add Record to Same Parent  or Add Sub-Record  and 

choose which level.  A new record window will open and the record will 

be added to the same collection at the level you chose. 

 

• You can load the sub-records of a record to the List Pane by right-clicking 

and choosing Use Sub-Records  then the level to load.  You can also 

load the records at the same level by choosing Use Records at Current 

Level .  A hierarchical range is set for that collection. 

 

• The Hierarchical browse window can remain open while you work in the 

main screen so that you can toggle between the views.  To toggle between 

screens, press Alt-Tab. 
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K. Field Types  

1. What are the icons that 
appear on each field? 

The icons identify the field type.  Different field types work in different ways 

to help you enter data more efficiently and accurately.  The table below 

describes each of the field types. 

Icon Field Type Description 

(none) Simple Text This is a straight entry field of limited length.  Some unedited fields only 

accept numeric entries. 

 Numeric Accepts only numbers.  Some numeric fields are formatted to allow decimal 

places.  In Add, Copy, or Modify modes, press F4 or click the down arrow to 

open a calculator. 

 Authority Table As you type, the program will autofill the term from the user-built table.  Press 

F5 to select from the table.  Note:  If there are no entries in the table, you will 

need to add terms before using these features.  Press Ctrl-F5 or right-click and 

choose Browse Authority Table to add to and edit the table.  To choose an 

entry from the table, highlight the entry and press Enter, or click Select.  Press 

Ctrl-Delete to remove data from the field.   

 Locked Authority 
Table 

As you type, the word will complete from an authority table of acceptable 

terms.  Press the F5 key to view and select terms from the table.  No users can 

edit the terms in a locked table.  Press Ctrl-Delete to remove data from the 

field. 

 Stacked Authority 
Table 

You can enter multiple terms.  Begin typing or press F5 to select terms from 

the table.  Note:  If there are no entries in the table, you will need to add terms 

before using these features.  Press Ctrl-F5 to edit the table.  Press F12 to 

expand the field and select more terms.  Press Enter or the down arrow key, or 

click Add, to select additional terms for this record.  Click Save to save and 

return to the main window.  Multiple terms are separated by double dashes (--).   

Press Ctrl-Delete to remove data from the field. 

 
Standard Date Enter only valid dates in a MMDDYYYY format, e.g., 01/23/2006.  In Add, 

Copy, or Modify modes, press F4 or click the calendar icon to open a calendar. 

 
Flexible Date Allows dates entered in various formats, such as 1910-1920, or ca. 1950.  You 

can enter the date or press F12 to open the flexible date entry screen.  The 

flexible date entry allows you to enter a beginning and ending date by century 

or year, month, and day.  It includes a user-built table of modifiers, for entries 

such as "circa," and a choice of AD or BC.  Use flexible dates when exact dates 

are unclear.   For more information on Flexible Date fields, refer to Section K, 

question 4, below. 

 
Memo Enter an unlimited amount of text.  Press F12 or right-click and select Zoom to 

expand to a larger window.   Press F5 to access the AAT from any memo field. 

 
Formatted Memo Begin typing, press F12 or right-click and select Zoom to expand the field.  

Formatted memo fields can include up to sixteen subfields.  Each of the 

subfields can be of any field type.  Press Tab to move through the subfields. 
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Repeating 
Formatted Memo 

Begin typing, press F12 or right-click and select Zoom to expand the field.  

Repeating formatted memo fields can include up to sixteen subfields in 

repeating sets displayed in a grid.  Each of the subfields can be of any field 

type.  Press Tab to move through the grid.  Press Ctrl-Tab to exit the grid and 

select Save and Close.  With Save and Close highlighted, press enter to save 

your changes or click Save and Close or Save.  When saved, an underline __ 

separates terms, and double bars || separate rows.   

 
Lexicon As you type, the word will complete from a lexicon authority table.  Press the 

F5 key to browse the lexicon and select a term from the list.  Press Ctrl-Del to 

remove data from the field. 

 
Patron ID Links to the Names and Addresses submodule.  You can enter multiple terms.  

Begin typing or press F5 to select from the Names and Addresses table.  Note:  

If there are no entries in the table, you will need to add names before using 

these features.  Press Ctrl-F5 to add to and edit the table.  Press F12 to expand 

the field and select more terms.  Press Enter or the down arrow key, or click 

Add, to select additional names for this record.  Click Save to save and return 

to the main window.  Multiple terms are separated by double dashes (--).  Click 

the Record Link icon  to view the full Names and Addresses record.  Press 

Ctrl-Delete to remove data from the field. 

 
Artist Name Links to the Artist/Maker/Eminent Figure submodule.  You can enter multiple 

terms.  Begin typing or press F5 to select from the Artist table.  Note:  If there 

are no entries in the table, you will need to add names before using these 

features.  Press Ctrl-F5 to add to and edit the table.  Press F12 to expand the 

field and select more terms.  Press Enter or the down arrow key, or click Add, 

to select additional names for this record.  Click Save to save and return to the 

main window.  Multiple terms are separated by double dashes (--).  Click the 

Record Link icon  to view the full Artist record.  Press Ctrl-Delete to 

remove data from the field. 

 
Exhibit ID Links to the Exhibits submodule.  As you type, the program will autofill the 

entry from the Exhibits submodule.  Press F5 to select from the table.  Note:  If 

there are no entries in the table, you will need to add entries before using these 

features.  Press Ctrl-F5 or right-click and choose Browse Authority Table to 

edit/add Exhibit records.  To choose an entry from the table, highlight the entry 

and press Enter, or click Select.  Click the Record Link icon  to view the 

full Exhibit record.  Press Ctrl-Delete to remove data from the field. 

 
Loans In ID Links to the Loans In submodule.  As you type, the program will autofill the 

entry from the Loans In submodule.  Press F5 to select from the table.  Note:  

If there are no entries in the table, you will need to add an entry before using 

these features.  Press Ctrl-F5 or right-click and choose Browse Authority Table 

to edit/add Loans In records.  To choose an entry from the table, highlight the 

entry and press Enter, or click Select.  Click the Record Link icon  to view 

the full Loans In record.  Press Ctrl-Delete to remove data from the field. 

 
Loans Out ID Links to the Loans Out submodule.  As you type, the program will autofill the 

term from the Loans Out submodule.  Press F5 to select from the table.  Note:  

If there are no entries in the table, you will need to add an entry before using 

these features.  Press Ctrl-F5 or right-click and choose Browse Authority Table 

to edit/add Loans Out records.  To choose an entry from the table, highlight the 

entry and press Enter, or click Select.  Click the Record Link icon  to view 

the full Loans Out record.  Press Ctrl-Delete to remove data from the field. 
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2. What is the purpose of the 

authority tables in the 
program? 

Authority tables (also called pick lists or lookups) shorten data entry time.  

Tables are alphabetized lists of acceptable terms for a field.  When you start 

typing, the program “autofills” the matching term from the table.  You can 

also press F5 to view and select terms from the table.  Type the first letter of a 

word to move through the table.  To choose an entry from the table, highlight 

the term and press the Enter key. 

 

Tables also provide standardized terms for consistency, making your data 

more accurate by reducing typographical errors.  If you have the appropriate 

security rights, you can add, modify, or delete terms in a user-built table.  The 

security function allows you to control the number of staff who can update 

authority tables, so you can maintain consistent terms. 

 

Locked authority tables provide consistent entries on a service-wide basis.  

Locked authority tables are used for fields such as Object Status and 

Condition that provide information on service-wide collections status. 

3. How do I add, edit, or delete 
terms in an authority table? 

Press Ctrl-F5 or right-click and choose Browse Authority Table to access the 

table.  Select a term in the list, then click the Add Term, Edit Term, or Delete 

Term link for the action you want. 

 

 
 

Enter the data you want to appear in the table on the Term field.  Optionally, 

include a Description of the term, and an Extended Description.  Click the 

Save Change link to save your change to the authority table. 

4. What is a Flexible Date 
field? 

Flexible Date is a field type that allows you to enter date information in a 

variety of formats.  Flexible date fields also allow you to enter partial dates, 

such as a month and year.   

 

The symbol for a flexible date field is .  There are several flexible date 

fields in the program.  They include Manufacture Date, Collection Date, and 

Identified By Date. 
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5. Do I have to use the flexible 
date format? 

No.  You can enter a valid date format directly into the field, such as 

01/23/2006.  Valid formats include 23JAN2006; Jan. 23, 2006; and Jan. 

2006.  If you press F12 to expand the flexible date field, it will translate such 

entries into the 1/23/2006 format.  If the date you enter is in a valid format, 

simply tab to the next field. 

 

The program will not translate two-digit year entries to four-digit years.  For 

example, the entry 12/12/98 will not become 12/12/1998. 

6. How do I use the Flexible 
Date Format window? 

Press F12 or click the  icon to open the Flexible Date Format window. 

 

 

 • Select either Year Format or Century Format 

 

• Complete the Beginning Date and (optional) Ending Date fields with the 

date information you have available. 

 

• Click the Save and Close link to save your data and close the Flexible 

Date Format window. 

 You can enter a Beginning Date, for example the earliest date when an object 

was manufactured.  You can also enter an optional Ending Date, for example 

the last know date when an object was manufactured.  Beginning Date and 

Ending Date have the same set of fields.  They are: 

 

For Year Format: 

• Modifier, a user-built authority table 

• Year, a simple text field allowing only a 4-digit year 

• Month, a simple text field allowing only a 2-digit month 

• Day, a simple text field allowing only a 2-digit day 

• Era, a user-built authority table 

 

For Century Format: 

• Modifier, a user-built authority table 

• Century, a user-built authority table 

• Era, a user-built authority table 
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7. What fields allow me to use 

Spell Check? 
You can use Spell Check for all memo fields within the catalog records and 

the associated modules.  Numeric fields, date fields, and fields controlled by 

authority tables are not checked by Spell Check. 

8. How do I activate Spell 
Check? 

To activate Spell Check, select Spell Check from the Tools menu.  The Spell 

Checker window opens. 

 

 

9. How do I use Spell Check? First, select a Dictionary to use.  The default dictionary is United Stated 

English, but other dictionaries are available from the pull-down menu.  Next: 

 

• choose to check All Fields and click the Spell Check link, or 

 

• choose to check Selected Fields.  Then select the field(s) you want to 

check, and click the Ok link.  Then click the Spell Check link 

 

If spelling errors are found, the Spell Check window will open. 

 

 
 

The Spell Check window shows you which word it found questionable.  You 

can: 
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• Enter a corrected spelling in the Replace with field, and click the 

Replace button, or  

 

• Click the Ignore button to ignore the questionable spelling, or 

 

• Click the Ignore All button to ignore all instances of this spelling in 

the record, or  

 

• Click the Add button to add this word to the dictionary, or  

 

• Select a suggested word and click the Replace button, or  

 

• Select a suggested word and click the Replace All button to replace 

all instances of this spelling in this record, or  

 

• Click the Cancel button to close the Spell Check window 

L. Using the Program  

1. What kind of help is 
available in the program? 

There are two types of help in the program.  Rediscovery System Help is 

available under Help on the menu bar.  ICMS field help is available on the 

Navigation Pane. 

2. What is Rediscovery 
System Help? 

Rediscovery system help provides assistance on how the system works.  It 

includes how-to guidance on menu commands and functions within the 

program.  It includes the same content as the Re:discovery User Manual.  

Click the  System Help icon on the button bar, or press F1 to open the 

Rediscovery System help. 

3. What is ICMS field help? ICMS field help provides field-by-field DOI guidance on completing the data 

fields on the screen.  Field help is located in the Navigation Pane.  The field 

help will tell you: 

 

• the type of field 

 

• what data to enter in the field 

 

• how to enter data in the field 

 

• whether the field is mandatory 

 

• whether the field maps to a form or report 

 

• whether the field maps to the Archives Module (for cultural resources 

archives records) 

 

Most field help also includes examples. 

4. Should I enter data in all 
caps or mixed case? 

Entering data in all caps is strongly recommended, especially for authority 

table terms.  All the terms in DOI locked tables are in all caps.   

 

Note:  For some archival fields, mixed case entries are recommended because 

the information will print as part of the finding aid. 
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5. Do I really need to learn how 
to use all the different 
modules and functions? 

The program is comprehensive, but learning to use it is easy and worthwhile.  

It has been customized to perform the collections management procedures 

outlined in the DOI Museum Property Handbook and NPS Museum 

Handbook, Parts I and II.  Use it to carry out collections management 

procedures that you already do.  As you become familiar with the program, 

you'll find yourself saving more and more time. 

 

The program is designed so that many of the functions operate in the same 

way.  When you learn to perform one function, you will know how to do 

other similar functions.   

 

For example, the process of selecting fields is the same for Quick Report, 

Quick Entry, and the Import and Export functions.  The process for attaching 

collection records is the same for incoming loans, outgoing loans, exhibits, 

deaccessions, and restrictions. 

6. What are the most important 
things to remember while 
working in the program? 

As you work, remember to: 

 

• Be aware of the mode in which you are operating: Browse, View, Add, 

or Modify.  Check the bottom right corner of the status bar. 

 

• Be aware of the "visible" data with which you are working.  Look for 

active tag sets and filters indicated on the status bar. 

 

• Know the current sort order.  Check the Sort field on the button bar. 

7. Can I change the screen 
style and colors or button 
bar size? 

Yes.  There are several themes available for the screen and Navigation Pane 

as well as two sizes for the button bar.  These settings are user specific and 

are tied to the user login so that each person can have their own style. 

 

To change the Screen style and button bar size: 

 

• On the View menu, select Screen Options. 
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 • The default theme for the screen is Money Twins.  Select any style you 

prefer under Theme Selection.  An example of the theme will be 

displayed on the right.  These themes affect the List Pane and Record 

Pane only. 

 

• To change the size of the buttons on the button bar, select either Small 

Images or Large Images under Toolbar Images on the left.  An example 

of the toolbar will display on the right. 

 

• After making your selections, click OK to save them.  If you only change 

the theme, the screen will immediately display your new settings.  If you 

also change the button bar size, you will have to exit the program and log 

back in to see the change. 

 

Note:  If you want to return to the default settings for the system, click the 

Set System Default on the toolbar. 

 You can also change the style of the Navigation Pane.  To change the 

Navigation Pane: 

 

• On the View menu, select Navigation Pane Style. 

 

 
 

• There are four styles available for the Navigation Pane:  Theme Style, 

Outlook 2003, Outlook XP and Windows Explorer XP.  Select one of the 

styles.  You will see the new setting in the Navigation Pane immediately. 

 

Note:  The Navigation Pane in the single record window has its own setting.  

Change it the same way as above if you want them to match. 



System Basics 1:50 ICMS User Manual (2015) 

8. What do I do next? You are ready to use the system.  How you plan to use ICMS will determine 

what you should do next. 

 

If you... Then... 

need to locate information become familiar with word searches.  

 Refer to Chapter 7, Finding and 

 Grouping Records, for additional help 

 on word searches. 

 

are a cataloger turn to Chapter 2, Cataloging.  Read 

 through the instructions for cataloging  

 the type of objects that you have. 

 

are responsible for the Read Chapter 8, Moving and Sharing  

database Data, and Chapter 9, Tools. 

  

 

 


